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WYMOGI BEZPIECZEŃSTWA

Poniższe wymogi bezpieczeństwa nie zawierają wszystkich informacji dotyczących działania 
urządzenia. Należy się zapoznać z niniejszą instrukcją obsługi w całości!

UWAGA: Wszelkich  podłączeń  i  zmian  należy  dokonywać  przy  odłączonym  napięciu
zasilającym.

UWAGA: Instalacja  oraz  programowanie  urządzenia  wymagają  posiadania  odpowiednich
umiejętności,  dlatego  mogą  być  dokonywane  tylko  przez  wykwalifikowany
personel po zapoznaniu się w całości z instrukcją obsługi.

UWAGA: W przypadku,  gdy urządzenie ulegnie  uszkodzeniu,  należy  skontaktować się  ze
sprzedawcą lub osobą odpowiedzialną za instalację. 

UWAGA: Nieprawidłowo podłączone urządzenie może ulec uszkodzeniu.

UWAGA: Odpowiedzialność  za  prawidłową  instalację  urządzenia  spoczywa  na  osobie
montującej. Należy się upewnić czy spełnione zostają wszystkie wytyczne i normy
obowiązujące w danym kraju. 

UWAGA: Wyładowania  elektrostatyczne  mogą  uszkodzić  urządzenie.  Należy  stosować
odpowiednie zabezpieczenie.

UWAGA: Wszelkie nieautoryzowane przeróbki, modyfikacje oraz próby naprawy powodują
utratę gwarancji. 
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2. Wstęp

Moduł MCTH-1 służy do pomiaru temperatury i wilgotności. Moduł może być zasilany napięciem
od 9 do 24V prądu stałego (DC). Maksymalny pobór prądu wynosi 100mA przy napięciu zasilania
24VDC i zależy od długości magistrali RS485, ilości świecących diod LED, temperatury otoczenia
oraz napięcia zasilania modułu. Wymiary modułu pozwalają na zmieszczenie go w standardowej
puszce instalacyjnej. 

Rys. 1. Widok modułu MCTH-1

3. Dane techniczne

Tabela 1. Parametry graniczne

Nazwa parametru Uwagi Min. Max.

Napięcie zasilania
24VDC

Notka 1 35VDC

Temperatura Notka 1 -20ºC 90ºC

Napięcie na
wyprowadzeniach

SDA, SCL
-0.7VDC 6VDC

Uwaga: Przekroczenie parametrów granicznych może spowodować uszkodzenie urządzenia,
lub/i  trwałe obniżenie parametrów. Długotrwała praca w warunkach bliskich parametrom
granicznym  może  spowodować  nieprawidłowe  działanie  układu,  a  nawet  uszkodzenie
urządzenia.
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Tabela 2. Rekomendowane warunki pracy

Nazwa parametru Uwagi Min. Typ. Max.

Napięcie zasilania
24VDC

9VDC 24V 32VDC

Prąd zasilania 24VDC 50mA 100mA

Napięcie na
wyprowadzeniach

SDA, SCL
0VDC 5.1VDC

Temperatura pracy -40ºC 80ºC

Wilgotność Notka 1 5% 95%

Wysokość 0m n.p.m. 2000m n.p.m.
Notka 1: Wilgotność bez kondensacji!

4. Instalacja

4.1. Podłączenie obwodu elektrycznego

4.1.1. Rozmieszczenie konektorów modułu wyjść

Rys. 2. Rozmieszczenie konektorów modułu wyjść
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Opis konektorów:

J1: Złącze podłączenia czujnika
J2: Złącze zasilające i komunikacyjne

Uwaga: Podłączanie niezgodne z instrukcją może spowodować nieprawidłową pracę i/lub 
uszkodzenie urządzenia nie objęte gwarancją!

4.1.2. Rozmieszczenie elementów na płytce. 

Rys. 2. Rozmieszczenie elementów na płytce modułu, dostępnej 
po odkręceniu dekielka

D1..D3 – diody LED sygnalizujące stan urządzenia
SW100 – przełącznik konfigurujący prędkość komunikacji, adres płytki oraz tryb Modbus

Uwaga: Podłączanie niezgodne z instrukcją może spowodować nieprawidłową pracę i/lub
uszkodzenie urządzenia nie objęte gwarancją!

D1(światło czerwone): Zasilanie CPU: miganie oznacza poprawną pracę urządzenia.
D2(światło zielone): Odbiór RS-485: miganie kontrolki oznacza odbieranie danych po RS-485.
D3(światło  czerwone): Nadawanie RS-485, miganie kontrolki oznacza wysyłanie danych 
                                           po RS-485.

Nieprzerwane świecenie  diod RX i TX sygnalizuje możliwość błędu w podłączeniu sygnałów  do 
gniazda. Miganie tylko diody sygnalizującej odbieranie danych przez moduł sygnalizuje 
możliwość wysyłania błędnego adresu, lub wybranie błędnych parametrów transmisji 
(nieprawidłowa prędkość, ustawienia parzystości, liczba bitów stopu, itp.)
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4.1.3. Złącze wyjściowe J1

Rys. 4. Widok konektora wyjściowego J1. 

Tabela 3. Opis wyprowadzeń na złączu J1:
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Numer 
wyprowadzenia

Nazwa Opis

1 SCL Komunikacja z czujnikiem

2 SDA Komunikacja z czujnikiem

3 GND Minus zasilania czujnika

4 +5V Plus zasilania czujnika
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4.1.4. Złącze zasilające i komunikacyjne J2 modułu MCTH-1

Rys. 5. Widok konektora zasilającego i komunikacyjnego J2

Tabela 4. Opis wyprowadzeń na złączu J2:

Numer
wyprowadzenia

Nazwa Opis

1 GND Minus zasilania

2 +24VDC Plus zasilania

3 D+ interfejs RS-485

4 D- interfejs RS-485
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4.1.5. Przykład typowego podłączenia.

Na rysunku 6 pokazano przykład typowego podłączenia modułu wyjść do sterownika PLC firmy
Fatek przy pomocy interfejsu RS485.

Rys. 6. Przykład typowego podłączenia modułu MCTH-1 do sterownika PLC FATEK
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4.2. Instalacja mechaniczna, wymiary.

Na rysunku poniżej pokazano wymiary obudowy modułu wyjść. Obudowa jest przystosowana do
montażu w puszce elektroinstalacyjnej φ 60.

Rys. 7. Wymiary obudowy modułu wyjść MCTH-1
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4.3. Ustawianie adresu Modbus za pomocą switcha SW100

4.3.1. Ustawianie adresu Modbus za pomocą switcha SW100

Rys. 8. Switch SW100 do ustawiania adresu Modbus (zworki 1-6)
Na rysunku przedstawiono 31 z 63 możliwych ustawień adresu.

W położeniu przedstawionym na rysunku, zworka w pozycji OFF oznacza 0, w pozycji ON – 1. 

W switchu SW100 zworki 1..6 służą do ustawienia adresu w protokole Modbus:
1 – A0 (najmniej znaczący bit adresu - LSB),
2 – A1,
3 – A2,
4 – A3,
5 – A4,
6 – A5 (najbardziej znaczący bit adresu – MSB).

Adres modułu wyjść w protokole Modbus:
- ustala się sprzętowo za pomocą switcha SW100, 
- może przyjmować wartości 1..63, 
- adres 0 jest zarezerwowany w specyfikacji protokołu Modbus jako rozgłoszeniowy (broadcast), 
- ustawia się w postaci binarnej, tzn. 27 (dec) = 011011 (bin). Switch w pozycji ON to bit adresu
ustawiony jako 1. Switch w pozycji OFF to bit adresu ustawiony jako 0. 

Uwaga:  Aby  zmienić  adres  modułu  w  protokole  Modbus,  prędkość  transmisji  lub  tryb
RTU/ASCII,  należy  ustawić  żądane  parametry,  a  następnie  wyłączyć  i  włączyć  zasilanie.
Zmiana parametrów przy włączonym zasilaniu nie odniesie skutku. Nastąpi to dopiero przy
ponownym uruchomieniu urządzenia.
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4.3.2. Ustawianie prędkości transmisji za pomocą switcha SW100.

Zworka 8 ze switcha SW100 służy do ustawiania prędkości transmisji:
OFF – prędkość 9600 bps
ON – prędkość 57600 bps

4.3.3. Ustawianie trybu Modbus (RTU/ASCII) za pomocą switcha SW100.

Zworka 7 ze switcha SW100 służy do ustawiania typu Modbus:
OFF – RTU
ON – ASCII

Uwaga:  W module  wyjść  i  urządzeniu  nim  sterującym  muszą  być  ustawione  takie  same
parametry transmisji!

5. Konfiguracja

5.1. Parametry transmisji danych

Moduł  komunikuje  się  z  urządzeniem  sterującym  za  pomocą  protokołu  Modbus  RTU/ASCII.
W warstwie fizycznej połączenie jest realizowane za pomocą interfejsu RS-485 2W, half-duplex
(z przełączaniem kierunku transmisji). 

Tabela 5. Parametry transmisji w trybie RTU:
prędkość: 9600/57600 baud (przełączane zworką)
parzystość: Even
ilość bitów danych: 8
ilość bitów stopu: 1

Tabela 6. Parametry transmisji w trybie ASCII:
prędkość: 9600/57600 baud (przełączane zworką)
parzystość: Even
ilość bitów danych: 7
ilość bitów stopu: 1

Tabela 7. Rejestry Modbus i ich znaczenie w module temperatury i wilgotności:
Numer rejestru Nazwa Opis

1100 Autokonfiguracja (111) Rejestr do konfiguracji

1101 Wersja firmware Numer wersji oprogramowania

1200 Odczyt temperatury z czujnika Wartość  temperatury  odczytana
bezpośrednio z czujnika

1201 Odczyt wilgotności z czujnika Wartość  wilgotności  odczytana
bezpośrednio  z  czujnika  (bez
kompensacji)

1202 Error Pojawienie  się  wartości  innej
niż zero sygnalizuje błąd
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1203 Czas pomiędzy odczytami Ustawiany, domyślnie 1s

1204 Temperatura skompensowana Float, starsze 16 bitów

1205 Temperatura skompensowana Float, młodsze 16 bitów

1206 Wilgotność skompensowana Float, starsze 16 bitów

1207 Wilgotność skompensowana Float, młodsze 16 bitów

1208 Temperatura znak Znak temperatury 0: +, 1: –  

1209 Temperatura całkowita Część całkowita temperatury

1210 Temperatura reszta Część ułamkowa temperatury

1211 Wilgotność całkowita Część całkowita wilgotności

1212 Wilgotność reszta Część ułamkowa wilgotności

Przykład:
Adres 1100: 111
Adres 1101: 210
Adres 1200: 6439
Adres 1201: 2080
Adres 1202: 0
Adres 1203: 2
Adres 1204: 7864
Adres 1205: 16835
Adres 1206: 16525
Adres 1207: 17032
Adres 1208: 1
Adres 1209: 25
Adres 1210: 6
Adres 1211: 73
Adres 1212: 4

Tabela  8.  Interpretacja  przykładowych  wartości  znajdujących  się  w  rejestrach  Modbus
w module temperatury i wilgotności
Autokonfiguracja 111  oznacza  moduł  pomiaru

wilgotności i temperatury
Wersja firmware 210 oznacza wersję 2.1.0
Odczyt temperatury z czujnika: 6439 jednostek własnych
Odczyt wilgotności z czujnika: 2080 jednostek własnych, brak błędów
Pomiar temperatury: co 2s
Skompensowana wartość temperatury 
w postaci zmiennoprzecinkowej: 

starsze 16 bitów: 7864, 
młodsze 16 bitów: 16835

Skompensowana wartość wilgotności 
w postaci zmiennoprzecinkowej:

starsze 16 bitów: 16525, 
młodsze 16 bitów: 17032

Adresy 1208..1210: temperatura -25.6 st.C
Adresy 1211..1212: wilgotność 73.4%

Aby zobaczyć temperaturę i wilgotność w czytelnym, znormalizowanym formacie, należy w tablicy
„StatusPage”  programu  WinProLadder  wypisać  w  postaci  „Floating”  wartości  podwójnych
rejestrów  DR  odpowiadających  skompensowanej  temperaturze  i wilgotności.  Dla  powyższego
przykładu będzie to wyglądać następująco:

Ref. No. Status Data
Odczyt temperatury: DR1204 Floating 24,3899
Odczyt wilgotności: DR1206 Floating 68,12607
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5.2. Przykład podłączenia modułu do sterownika PLC Fatek

Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port
w  sterowniku  PLC.  Możemy tego  dokonać  za  pomocą  programu   WinProLadder.  Wybieramy
z menu PLC → Setting → Port (numer portu, po którym będzie odbywała się komunikacja): 

Rys. 9. Wybór portu komunikacyjnego w sterowniku PLC

Po wybraniu  odpowiedniego portu musimy go skonfigurować.  Ustawiamy parametry transmisji
w trybie RTU:

Prędkość (Baud Rate): 9600/57600 (ustawiane zworką) 
Parzystość (Parity) even
Ilość bitów danych (Data Bit): 8
Ilość bitów stopu: (Stop Bit) 1
Protokół Modbus RTU (slave)
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Rys. 10. Konfiguracja portu komunikacyjnego sterownika PLC, w trybie RTU

Po wybraniu  odpowiedniego portu musimy go skonfigurować.  Ustawiamy parametry transmisji
w trybie ASCII:

Prędkość (Baud Rate): 9600/57600 (ustawiane zworką) 
Parzystość (Parity) even
Ilość bitów danych (Data Bit): 7
Ilość bitów stopu: (Stop Bit) 1
Protokół Modbus ASCII (slave)

Rys. 11. Konfiguracja portu komunikacyjnego sterownika PLC, w trybie ASCII
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Sterownik  ustawiony  jako  „master”  musi  mieć  uruchomioną  funkcję  M_BUS  (funkcja  150).
W funkcji M_BUS (150) użytkownik ustawia tylko port, którego będzie używał do komunikacji,
rejestr startowy programu do komunikacji oraz rejestr roboczy. 

Funkcja 150.M_BUS

Rys. 12. Symbol funkcji 150.M_BUS

Pt: Numer portu, który ma być użyty do komunikacji
SR: Rejestr startowy 
WR: Rejestr roboczy 
Jeżeli wejście A/R = 0   - protokół Modbus
Jeżeli wejście A/R = 1   - protokół Modbus ASCII
Jeżeli wejście ABT zmieni się na 1, operacja zostaje przerwana i po jej wznowieniu przesyłanie
zaczyna się od pierwszego pakietu danych.

Kiedy już zostanie skonfigurowany port oraz wstawiona funkcja 150.M_BUS,  tworzymy tabelę.
Z menu wybieramy Project → Modbus Master Table → Add Modbus Master Table.

Rys. 13. Widok ekranu przy wstawianiu z menu tabeli do obsługi Modbusa w programie
WinProladder.
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Rys. 14. Widok ekranu przy wstawianiu z drzewa konfiguracji tabeli do obsługi Modbusa 
w programie WinProladder.

Po wybraniu Add Modbus Master Table pojawi się okno Table Edit. 

Rys. 15. Okno konfiguracji funkcji Modbus w sterowniku FATEK.

W polu Table Name użytkownik może wpisać dowolną nazwę np. modbus, natomiast w polu Table
Starting  Address  należy  wpisać  rejestr  startowy,  który  został  użyty  w  programie  w funkcji
150.M_BUS, np.: R1000. Następnie po pojawieniu się okna Modbus Master Table można dodawać
komendy. 
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Rys. 16. Okno edycji komend w komunikacji Modbus.

Po naciśnięciu przycisku Add pojawia się okienko Command Item, w którym należy wprowadzić
numer stacji Slave Station (adres modułu), następnie wybrać rodzaj komendy (read/write), rozmiar
przesyłanych danych, adres startowy w sterowniku „master” oraz adres startowy w module.

Przykładowa konfiguracja (odczyt temperatury):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read (Odczyt)
Data Size: 2 (starsze i młodsze słowo temperatury)
Master Data Start Address: np.: R400 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401204 (początkowy rejestr odczytywany z modułu)

Przykładowa konfiguracja (odczyt wilgotności):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read (Odczyt)
Data Size: 2 (starsze i młodsze słowo wilgotności skompensowanej)
Master Data Start Address: np.: R402 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401206 (początkowy rejestr odczytywany z modułu)

Przykładowa konfiguracja (zmiana czasu odczytu):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Write (Zapis)
Data Size: 1 
Master Data Start Address: np.: R412 (zapisuje do modułu wartość z tego rejestru)
Slave Data Start Address: np.: 401203 (docelowy adres w module)

Przykładowa konfiguracja (odczyt błędu):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read (Odczyt)
Data Size: 1 
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Master Data Start Address: np.: R413 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401202

Przykładowa konfiguracja (odczyt temperatury i wilgotności):
Slave Station: 2 (adres fizyczny modułu równy 2)
Command: Read
Data Size: 5 
Master Data Start Address: np.: R415 (odczytuje wartości z modułu do tych rejestrów)
Slave Data Start Address: np.: 401208 (docelowy adres w module)

5.3. Przykład podłączenia modułu do panelu HMI

Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port
w panelu HMI. Możemy tego dokonać za pomocą programu  EasyBuilder 8000.

Wybieramy z menu Edit → System Parameters….

Rys. 17. Okno do dodawania urządzeń podłączanych do panelu HMI

Następnie klikamy na New…, w efekcie czego pojawi się okno jak na rysunku poniżej:
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Rys. 18. Okno do edycji parametrów komunikacji

Możemy teraz ustawić parametry komunikacyjne urządzenia. Chcąc połączyć moduł z panelem po
magistrali Modbus, należy w danych polach wybrać:

PLC type - tryb komunikacji: MODBUS RTU
PLC I/F - typ portu, po którym będzie odbywać

się komunikacja:
RS-485 2W

PLC default station no.:
adres sprzętowy modułu 

pomiaru wilgotności i temperatury

COM:
numer i ustawienia portu, przez który odbywa

się komunikacja panelu HMI z modułem.

Aby ustawić te parametry, należy kliknąć na pole Settings… i wybrać odpowiednie wartości:

 COM (numer portu komunikacyjnego): COM 1
 Baud rate (prędkość komunikacji): 57600 
 Data bits (ilość bitów danych) 8
 Parity (parzystość): Even
 Stop bits (ilość bitów stopu): 1

Rys. 19. Ustawienia portu komunikacyjnego
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Przykładowa konfiguracja:

 Odczyt temperatury (lub wilgotności):

Aby odczytywać żądaną wartość z modułu,  należy utworzyć odpowiedni obiekt w panelu HMI
wyświetlający tę wartość. 

W tym celu wybieramy: menu Objects → Numeric/ASCII → Numeric Display

Rys. 20. Tworzenie obiektu Numeric Display

Pojawi  się  okno  Numeric  Display  Object’s  Properties,  w  którym  w celu  odczytu  temperatury
należy:

W zakładce „General” wybrać:
 Description (własny opis obiektu)
 PLC name: MODBUS RTU
 Device type: 4x
 Address (numer rejestru, który chcemy odczytać- patrz strona 7): 1204

(1204 dla temperatury,  1206 dla wilgotności)
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Rys. 21. Właściwości obiektu Numeric Display

W zakładce „Numeric Format” należy wybrać:
 Data Format: 32-bit Float
 Mask: Odznaczyć
 Left of decimal Pt: 3  (część całkowita)
 Right of decimal Pt: 4  (część ułamkowa)

Rys. 22. Właściwości obiektu Numeric Display

Po zatwierdzeniu ustawień możemy ulokować obiekt w dowolnym miejscu przestrzeni roboczej
programu  EasyBuilder.  Po  załadowaniu  programu  do  panelu  HMI  można  już  odczytywać
temperaturę. 

W celu zmiany wielkości okresu próbkowania należy wykonać tę samą procedurę co powyżej, z tą
różnicą,  że  nie  wybieramy już  obiektu  wyświetlającego  dane,  tylko  obiekt  odpowiedzialny  za
wpisywanie danych, czyli „Numeric Input”. W skrócie:
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W zakładce „General” wybrać:

1. Description (własny  opis
obiektu)

2. PLC name: MODBUS RTU
3. Device type: 4x
4. Address (numer rejestru przechowujący czas między odczytem): 1203

Rys. 23. Właściwości obiektu Numeric Display

W zakładce „Numeric Format” należy wybrać:

 Data Format: 16-bit Unsigned
 Mask: Odznaczyć
 Left of decimal Pt: 3 
 Right of decimal Pt: 0 
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Rys. 24. Właściwości obiektu Numeric Display

6. Uwagi końcowe

1. Producent zastrzega sobie prawo do wprowadzania ciągłych poprawek i ulepszeń.
2. Produkt może nieznacznie różnić się od fotografii.
3. Instrukcja  może zawierać  błędy.  Producent  nie  odpowiada za  jakiekolwiek uszkodzenia,

które  mogą  z  nich  wyniknąć.  Jednocześnie  producent  oświadcza,  że  dołoży  wszelkich
starań, by żadne błędy w instrukcji się nie pojawiły, a jeżeli tak się stanie, to informacje
o wszelkich błędach zamieści na swojej stronie internetowej. 

4. Producent nie odpowiada za żadne szkody wynikające z użytkowania urządzenia.
5. Aktualna wersja instrukcji znajduje się na stronie www.e-tronix.eu.
6. Wszelkie  uwagi  dotyczące  urządzenia  oraz  tej  instrukcji  oraz  pytania  w  sprawach

technicznych nie wyjaśnionych wyżej proszę kierować na e-mail: e-tronix@e-tronix.eu. 
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